
Your Office Microsoft 2010 Vol 1, 2e (Kinser)
Common Features, Workshop 1: Understanding the Common Features of Microsoft Office

1) Microsoft Word is a(n) ________ application.
A) presentation
B) spreadsheet
C) planner and note taking
D) word processing
Answer:  D
Diff: 1
Ref:  Working with the Office Interface and the Ribbon

2) Items such as pictures, clip art, SmartArt, shapes, and charts that you can add to a Word 
document are called ________.
A) graphics
B) photos
C) images
D) art
Answer:  A
Diff: 1
Ref:  Working with the Office Interface and the Ribbon

3) Microsoft Excel is a(n) ________ application.
A) spreadsheet
B) presentation
C) database
D) desktop publishing
Answer:  A
Diff: 1
Ref:  Working with the Office Interface and the Ribbon

4) Files created by Excel are called ________.
A) workbooks
B) databases
C) documents
D) worksheets
Answer:  A
Diff: 1
Ref:  Working with the Office Interface and the Ribbon
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5) Microsoft PowerPoint is a(n) ________ application.
A) planner and note taking
B) information management
C) spreadsheet
D) presentation
Answer:  D
Diff: 1
Ref:  Working with the Office Interface and the Ribbon

6) Microsoft Outlook is a(n) ________ program.
A) information management
B) presentation
C) spreadsheet
D) database
Answer:  A
Diff: 1
Ref:  Working with the Office Interface and the Ribbon

7) The application in the Microsoft Office suite that would be used to develop and maintain 
databases is called ________.
A) Publisher
B) Excel
C) Access
D) OneNote
Answer:  C
Diff: 2
Ref:  Working with the Office Interface and the Ribbon

8) Judy needs to create brochures, newsletters and postcards for her home business. She should 
use the Microsoft ________ program.
A) Excel
B) PowerPoint
C) Outlook
D) Publisher
Answer:  D
Diff: 2
Ref:  Working with the Office Interface and the Ribbon

9) A(n) ________ displays when you move your mouse pointer over an icon in the taskbar.
A) message box
B) document
C) dialog box
D) thumbnail
Answer:  D
Diff: 1
Ref:  Starting and Exploring Office Programs and Common Window Elements
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10) In Word, the ________ view shows how the document appears as a web page.
A) Print Layout
B) Browser Layout
C) Outline layout
D) Web Layout
Answer:  D
Diff: 2
Ref:  Starting and Exploring Office Programs and Common Window Elements

11) You can quickly switch between the views in Word by using the View buttons located on the 
right side of the ________.
A) title bar
B) scroll bar
C) taskbar
D) status bar
Answer:  D
Diff: 1
Ref:  Starting and Exploring Office Programs and Common Window Elements

12) The two tabs all Microsoft Office applications have in common are the ________.
A) Home tab and the Charts tab
B) Home tab and the File tab
C) Design tab and the File tab
D) Insert tab and the Mailing tab
Answer:  B
Diff: 3
Ref:  Using the Ribbon

13) The Formulas tab is specific to the ________ application.
A) Excel
B) Access
C) Publisher
D) OneNote
Answer:  A
Diff: 1
Ref:  Using the Ribbon

14) The Minimize Ribbon button is a ________ button that reduces the Ribbon to a single line.
A) checkbox
B) radio
C) toggle
D) switch
Answer:  C
Diff: 2
Ref:  Using the Ribbon
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15) A(n) ________ is a set of menu options that appear when you click the More button next to a 
Ribbon button.
A) option list
B) gallery
C) setup box
D) window
Answer:  B
Diff: 1
Ref:  Using the Ribbon

16) A(n) ________ pane is a smaller window pane that sometimes appears at the side of the 
program window and offers options or helps you navigate through completing a task or feature.
A) option
B) task
C) dialog
D) information
Answer:  B
Diff: 1
Ref:  Using the Ribbon

17) The ________ opens a dialog box, which provides more options or settings beyond those 
provided on the Ribbon.
A) Dialog Pane
B) TaskBar
C) Dialog Box Launcher
D) Task Pane
Answer:  C
Diff: 2
Ref:  Using the Ribbon

18) ________ options allow you to select more than one option.
A) Mini toolbar
B) Radio button
C) Check box
D) Keyboard shortcut
Answer:  C
Diff: 1
Ref:  Using Contextual Tools

19) A ________ option allows you to select ONLY one option.
A) Mini toolbar
B) Check box
C) radio button
D) Keyboard shortcut
Answer:  C
Diff: 1
Ref:  Using Contextual Tools
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20) When text is selected, a(n) ________ appears.
A) Mini toolbar
B) option box
C) dialog box
D) contextual tab
Answer:  A
Diff: 1
Ref:  Using Contextual Tools

21) A list of commands related to a selection that appears when you right-click is called a(n) 
________.
A) shortcut menu
B) dialog box
C) Mini toolbar
D) option menu
Answer:  A
Diff: 1
Ref:  Using Contextual Tools

22) To close an unwanted shortcut menu or gallery menu without making a selection, press the 
________ key.
A) Shift
B) ESC
C) Enter
D) Alt
Answer:  B
Diff: 2
Ref:  Using Contextual Tools

23) As you work, you should save your word at least every ________.
A) two minutes
B) twenty minutes
C) ten minutes
D) thirty minutes
Answer:  C
Diff: 1
Ref:  Using Contextual Tools

24) Until you save your work, it is stored in the ________ memory on your computer.
A) hard drive
B) temporary
C) CD drive
D) USB flash drive
Answer:  B
Diff: 1
Ref:  Working with Files
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25) Three ways to save a file are to use the Save button on the Quick Access Toolbar, use the 
Save command on the Backstage view, and use the keyboard shortcut key ________.
A) ESC+S
B) Tab+S
C) Alt+S
D) Ctrl+S
Answer:  D
Diff: 1
Ref:  Working with Files

26) Microsoft Office file names can be up to ________ characters, including the extension and 
the number of characters in the file path.
A) 255
B) 50
C) 300
D) 25
Answer:  A
Diff: 1
Ref:  Working with Files

27) Special characters you can NOT use in file names are ________.
A) ? / | < > * : ~
B) ? " / | < > * :
C) ? " / | < > ; :
D) ? " /\ | < > :
Answer:  B
Diff: 3
Ref:  Working with Files

28) One-click access to the most commonly used commands, such as saving a file and undoing 
recent actions is available on the ________.
A) Task bar
B) Ribbon
C) Quick Access Toolbar
D) Mini toolbar
Answer:  C
Diff: 1
Ref:  Working with Files
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29) When you open a file in ________, you must click the Enable Editing button before you can 
edit, save, or print the contents.
A) Shield View
B) Safeguard View
C) Defensive View
D) Protected View
Answer:  D
Diff: 1
Ref:  Working with Files

30) An online workspace provided by Microsoft is called the Windows Live ________.
A) SkyDrive
B) OnlineDrive
C) Windows Drive
D) WorkPlace
Answer:  A
Diff: 1
Ref:  Sharing Files Using Windows Live SkyDrive

31) According to the textbook, Microsoft provides ________ of free password protected online 
storage.
A) 25 GB
B) 250 GB
C) 100 MB
D) 25 MB
Answer:  A
Diff: 1
Ref:  Sharing Files Using Windows Live SkyDrive

32) Files saved to an online workspace can be edited by ________.
A) only two people at the same time
B) more than one person, but NOT at the same time
C) more than one person at the same time
D) only one person at a time
Answer:  C
Diff: 2
Ref:  Sharing Files Using Windows Live SkyDrive

33) The small window that displays descriptive text when you put the mouse pointer on an object 
or button is called a(n) ________.
A) ContextualTip
B) ScreenTip
C) OptionTip
D) HelpTip
Answer:  B
Diff: 1
Ref:  Getting Help
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34) In each program's ________ window, you can find step-by-step instructions for specific 
procedures.
A) Assistance
B) Support
C) Help
D) Utility
Answer:  C
Diff: 1
Ref:  Getting Help

35) ________ is the short cut key to access the Help window.
A) F2
B) F8
C) F3
D) F1
Answer:  D
Diff: 1
Ref:  Getting Help

36) A paper copy of a document, spreadsheet, or presentation is called a(n) ________.
A) soft copy
B) hard copy
C) page copy
D) print copy
Answer:  B
Diff: 1
Ref:  Printing a File

37) To avoid wasting ink and paper, you should do a ________ before printing.
A) document view
B) page preview
C) page view
D) print preview
Answer:  D
Diff: 1
Ref:  Printing a File

38) When you close a program, if you have made changes to the file, a dialog box opens, asking 
if you wish to ________ your changes.
A) import
B) discard
C) copy
D) save
Answer:  D
Diff: 1
Ref:  Exiting Programs
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39) When you are finished with a program, you should ________ the program to save system 
resources.
A) remove
B) exit
C) minimize
D) switch
Answer:  B
Diff: 1
Ref:  Exiting Programs

40) Microsoft OneNote is a program used to develop presentation slides.
Answer:  FALSE
Diff: 1
Ref:  Working with the Office Interface and the Ribbon

41) Access is a two-dimensional database program known as a relational database.
Answer:  FALSE
Diff: 3
Ref:  Working with the Office Interface and the Ribbon

42) Though each application in the Microsoft Office suite has common features in the user 
interface, each also has features specific to that application.
Answer:  TRUE
Diff: 3
Ref:  Working with the Office Interface and the Ribbon

43) You can only open ONE Microsoft application at one time.
Answer:  FALSE
Diff: 1
Ref:  Starting and Exploring Office Programs and Common Window Elements

44) In Word, the file you create is called a document.
Answer:  TRUE
Diff: 1
Ref:  Starting and Exploring Office Programs and Common Window Elements

45) In Excel, you have to add columns and rows to the document window before starting your 
spreadsheet.
Answer:  FALSE
Diff: 2
Ref:  Starting and Exploring Office Programs and Common Window Elements

46) In a new Excel spreadsheet, the active cell is the last cell of the first row.
Answer:  FALSE
Diff: 1
Ref:  Starting and Exploring Office Programs and Common Window Elements
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47) One method of switching between Windows is to use Alt+Tab.
Answer:  TRUE
Diff: 2
Ref:  Starting and Exploring Office Programs and Common Window Elements

48) The three buttons at the top right of each Microsoft Office application's title bar are called 
the Minimize button, the Restore Down or Maximize button, and the Open button.
Answer:  FALSE
Diff: 1
Ref:  Starting and Exploring Office Programs and Common Window Elements

49) The Maximize button at the far right of the application's title bar expands the window to its 
full size.
Answer:  TRUE
Diff: 1
Ref:  Starting and Exploring Office Programs and Common Window Elements

50) The zoom level on a Word document only affects your view of the document, not the printed 
output.
Answer:  TRUE
Diff: 2
Ref:  Starting and Exploring Office Programs and Common Window Elements

51) When the zoom level is set to 300%, vertical or horizontal scroll bars will display to make it 
possible to adjust what is displayed in the window.
Answer:  TRUE
Diff: 3
Ref:  Starting and Exploring Office Programs and Common Window Elements

52) Clicking any button on the Ribbon will produce an action ONLY if you are in the right 
layout view.
Answer:  FALSE
Diff: 2
Ref:  Using the Ribbon

53) The right mouse button provides options from which you can choose, instead of initiating or 
performing an action.
Answer:  TRUE
Diff: 2
Ref:  Using the Ribbon

54) Backstage view gives you access to document level features of your file.
Answer:  FALSE
Diff: 2
Ref:  Using the Ribbon
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55) An arrow next to a button in the Ribbon is an indicator that more options are available
Answer:  TRUE
Diff: 1
Ref:  Using the Ribbon

56) The Dialog Box Launcher opens a gallery of menu options.
Answer:  FALSE
Diff: 1
Ref:  Using the Ribbon

57) Unlike a radio button option, ONLY one check box option can be selected.
Answer:  FALSE
Diff: 1
Ref:  Using Contextual Tools

58) A Mini toolbar appears after text is selected and contains buttons for the most commonly 
used formatting commands.
Answer:  TRUE
Diff: 1
Ref:  Using Contextual Tools

59) A shortcut menu appears when an object or text is selected.
Answer:  FALSE
Diff: 1
Ref:  Using Contextual Tools

60) To prevent loss of work, you must save the work before exiting a program or turning off the 
computer.
Answer:  TRUE
Diff: 1
Ref:  Working with Files

61) File names can ONLY be 12 characters long, excluding the extension.
Answer:  FALSE
Diff: 1
Ref:  Working with Files

62) Windows Live SkyDrive is a free online file storage area that provides you with up to 25 GB 
of password protected storage space.
Answer:  TRUE
Diff: 1
Ref:  Sharing Files Using Windows Live SkyDrive
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63) A print preview allows you to see how a printed document will look so that you can correct 
any problems before wasting paper and ink.
Answer:  TRUE
Diff: 2
Ref:  Printing a File

64) To save system resources and keep your Windows desktop and taskbar uncluttered, you 
should always exit a program when you are finished using it.
Answer:  TRUE
Diff: 1
Ref:  Exiting Programs

65) Microsoft Office 2010 is a suite of productivity ________ or programs.
Answer:  applications
Diff: 2
Ref:  Working with the Office Interface and the Ribbon

66) The Microsoft Office application that is referred to as an information management program 
is ________.
Answer:  Outlook
Diff: 1
Ref:  Working with the Office Interface and the Ribbon

67) When you move your mouse pointer over one of the taskbar icons, a(n) ________ is 
displayed.
Answer:  thumbnail
Diff: 2
Ref:  Starting and Exploring Office Programs and Common Window Elements

68) If you need to see more of a documents contents, you can ________ out.
Answer:  zoom
Diff: 1
Ref:  Starting and Exploring Office Programs and Common Window Elements

69) A(n) ________ button turns on a feature if you click it once, then turns the same feature off 
if you click it a second time.
Answer:  toggle
Diff: 1
Ref:  Using the Ribbon

70) The options that appear on the ________ change depending on where the mouse pointer is 
located.
Answer:  shortcut menu
Diff: 2
Ref:  Using the Ribbon
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71) The feature that allows you to see how formatting looks before you apply it is called the 
________ feature.
Answer:  Live Preview
Diff: 1
Ref:  Using the Ribbon

72) The ________ opens a corresponding dialog box or task pane which provides more options 
or settings beyond those available in the Ribbon.
Answer:  Dialog Box Launcher
Diff: 1
Ref:  Using the Ribbon

73) When text is selected, a(n) ________ with the most commonly used formatting commands 
appears.
Answer:  Mini toolbar
Diff: 1
Ref:  Using Contextual Tools

74) A Ribbon tab that contains commands related to selected objects so that you can manipulate, 
edit and format the objects is called a(n) ________ tab.
Answer:  contextual
Diff: 2
Ref:  Using Contextual Tools

75) A(n) ________ is a list of commands that appears when you right-click.
Answer:  shortcut menu
Diff: 1
Ref:  Using Contextual Tools

76) If the computer is turned off or experiences a power failure, a feature that will attempt to 
recover your files is called the ________ feature.
Answer:  AutoRecovery
Diff: 1
Ref:  Working with Files

77) File names can include a maximum of ________ characters, including the extension.
Answer:  255
Diff: 1
Ref:  Working with Files

78) A file name includes the name you specify for the file and a file ________ that is assigned by 
the Office program to indicate the file type.
Answer:  extension
Diff: 2
Ref:  Working with Files
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79) Files names can include uppercase and lowercase letters, numbers, hyphens, spaces and some 
________ in any combination, except for ? " / | < > * and :.
Answer:  special characters
Diff: 3
Ref:  Working with Files

80) The ________ provides one-click access to commonly used commands.
Answer:  Quick Access Toolbar
Diff: 2
Ref:  Working with Files

81) When you open a file in ________ , you can see and read the file, but you CANNOT edit, 
save, or print the contents until you enable editing.
Answer:  Protected view
Diff: 2
Ref:  Working with Files

82) Using the Save & Send tab in the ________ view, you can easily e-mail a copy of your file 
to a friend.
Answer:  Backstage
Diff: 1
Ref:  Sharing Files Using Windows Live SkyDrive

83) The Windows Live ________ is a free online file storage area where you can save up to 25 
GB of files.
Answer:  SkyDrive
Diff: 2
Ref:  Sharing Files Using Windows Live SkyDrive

84) Before you can use SkyDrive, you must have a Windows Live ________.
Answer:  ID
Diff: 1
Ref:  Sharing Files Using Windows Live SkyDrive

85) ________ are small windows that display descriptive text when you put your mouse pointer 
on an object.
Answer:  ScreenTips
Diff: 1
Ref:  Getting Help

86) When you need to learn how to do a specific action in an Office application, you can open 
the ________ window to find step-by-step instructions.
Answer:  Help
Diff: 1
Ref:  Getting Help
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87) The keyboard shortcut used to access Help is the ________ key.
Answer:  F1
Diff: 1
Ref:  Getting Help

88) A paper copy of a document is also known as a(n) ________.
Answer:  hard copy
Diff: 1
Ref:  Printing a File
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